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1

Before You Begin

Welcome to the Transition Guide. This Transition Guide includes information that allows you to quickly transition to 

Foglight® 5 using from a Foglight 4 perspective. Use it to find your Foglight 4 components in Foglight 5, 
understand typical workflows, and perform some of the basic administrative tasks. This guide is intended for 
Foglight 4 users who are getting started with Foglight 5.

Before you get started with Foglight 5, you need to ensure that your system is up and running and that you have 
appropriate permissions to access all of the system components.

• Introducing Foglight 5

• How Do I Get Started?

Introducing Foglight 5
Foglight® 5 is a powerful performance management solution that builds data models in real time. Unlike Foglight 4, 
where metric collection is somewhat static, Foglight 5 offers more flexibility by organizing the data into a 
hierarchical structure.

In addition to the changes to data collection, Foglight 5 includes a portable, Web-based interface which eliminates 
the need for a platform-dependent administrative application. To access the administrative interface, simply launch 
a Web browser instance and go to the Foglight Console URL.

This manual helps you get started with Foglight 5 quickly and efficiently, understand typical workflows, and perform 
some of the basic administrative tasks. For complete information on how to administer and use Foglight 5, see the 
Administration and Configuration Help and the Foglight User Help.

In most scenarios, a typical workflow includes the following procedure.

To get started with Foglight 5:

1 Launch the Foglight Management Server, your Foglight Agent Manager instances, and log into Foglight. 
For instructions, see How Do I Get Started? on page 5.

2 Find Foglight 4 components in Foglight 5 using the administrative interface. Locate Foglight 5 agents, 
ASPs, rules, or registry variables. For more information, see Appendix: Finding Foglight 4 Components in 
Foglight 5 on page 112.

3 Familiarize yourself with typical workflows in Foglight 5. For example, find out what is the diagnostic 
workflow or where to find dashboards. For more information, see Finding Your Way Around: Finding Your 
Way Around on page 8.

4 Learn more about basic administrative tasks. For example, find out how to edit rules or registry variables. 
For more information, see Setting Up For Long-Term Use: Setting Up For Long-Term Use on page 49.

How Do I Get Started?
Before you start familiarizing yourself with the new environment, you need to ensure that you launch and obtain 

access to the following Foglight® 5 components:
Foglight 5.7.0 Transition Guide
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• Foglight Management Server

• Foglight Agent Manager

• A Foglight user name and password

To get started:

1 Ensure that your Foglight Management Server and each of your Foglight Agent Manager instances are up 
and running.

For example, on Windows® platforms, you can start the Foglight Management Server by choosing Start > 
Programs > Quest Software > Foglight 5.9.x > Start Foglight. To start the Foglight Agent Manager, on 
the monitored host, navigate to <foglight_agent_manager_home>/bin and from there, issue the fglam -s 
command. For more information about this and other Foglight commands, see the Command-Line 
Reference Guide.

2 Obtain your Foglight user name and password.

For more information, refer to the Installation and Setup Guide.

3 Start the Foglight Console.

You can start the Foglight Console by opening a Web browser instance and navigating to the following 
URL:

http://localhost:8080/console

Where localhost is the name of the machine that is running the Foglight Management Server.

The Foglight login page appears in the Web browser.

4 Provide the user name and password you obtained in Step 2.

The Welcome to Foglight page appears in the display area.

 

The Welcome page lists several tasks that you can perform by clicking an entry in the list. The appearance 
of the age depends on your user permissions. If your user account belongs to a group that has the 
Administrator role, this is what you see when you log into Foglight for the first time. If you do not have the 
Administrator role, and you have the Operator role, a slightly different version of the Welcome page 
appears in the display area. For more information about the Welcome page, refer to the online help topic 
for this page. You can view this help topic by clicking More on the action panel’s Help tab.

NOTE: The above URL assumes the default HTTP port number, 8080. For more information about 
default port assignments, see the Foglight Administration and Configuration Help.
Foglight 5.7.0 Transition Guide
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From here, you can go to any of the following sections:

• Finding Your Way Around on page 8

• Setting Up For Long-Term Use on page 49
Foglight 5.7.0 Transition Guide
Before You Begin
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2

Finding Your Way Around

Once the Foglight® 5 components are up and running, you can start familiarizing yourself with Foglight 5 
workflows. This chapter gets you started with a basic set of tasks, such as where to find the administrative 
interface, how to start a typical workflow, how to define services, and other important features.

• Where’s the FOC?

• How Do I Know if My Agents Are Connected?

• How Do I Fix the Agents That Are Not Connected?

• What is My Single Pane of Glass?

• What Dashboards Are Available?

• How Do I Bookmark a Dashboard for Easy Access?

• How Do I Share My Dashboards with Other Users?

• What is the Diagnostic Workflow?

• How Do I Create Custom Maps?

• Where Are the Service Models?

• Why Do I See Only One Set of System Agent Variables?

• Can Multiple People Share My User Name?

• Can I Configure Everything to Look and Feel Like Foglight 4?

Where’s the FOC?
In Foglight® 5, the browser interface offers the functionality of the Foglight Operations Console (FOC) and Foglight 
Web Console through a comprehensive and intuitive interface, which lets you configure, administer, and manage 
Foglight in real time using a Web browser. The Web-based interface offers rich support for all of the FOC’s 
capabilities while eliminating the need for a platform-dependent administrative application.

To perform an administrative task, simply open a Web browser instance and navigate to the Foglight browser 
interface URL. From here, you can administer and manage users, agents, cartridges, and rules, and explore 
dashboards and metric collections.

For information on where to find some of the common interface components that you used in Foglight 4, such as 
service model or rule browsers, see Appendix: Finding Foglight 4 Components in Foglight 5 on page 112.

For information on the types and versions of Web browsers supported in Foglight 5, see the System Requirements 
and Platform Support Guide. To find out how to launch the Foglight Console, see How Do I Get Started? on page 
5. For complete information, refer to the Administration and Configuration Guide or the Foglight User Guide.

See also

• How Do I Get Started? on page 5

NOTE: Each of the procedures in this chapter continues from How Do I Get Started? on page 5.
Foglight 5.7.0 Transition Guide
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• How Do I Know if My Agents Are Connected? on page 9

• What is My Single Pane of Glass? on page 14

• What is the Diagnostic Workflow? on page 32

• Can I Configure Everything to Look and Feel Like Foglight 4? on page 47

How Do I Know if My Agents Are 
Connected?
In Foglight® 4 you could check the status of your agent instances by looking at the IP map either in the Foglight 
Operations Console or the Foglight Web Console.

Figure 1. Foglight 4 user interface

Foglight 5 offers two interfaces that let you find out if your agents are active and collecting data:
Foglight 5.7.0 Transition Guide
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Figure 2. Agent Status dashboard in the browser interface

Figure 3. Agents on All Hosts dashboard, a Foglight 5 equivalent of the IP map

To find out if your agents are connected using the Agent Status dashboard:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Agents > Agent Status.

The Agent Status dashboard appears in the display area, showing a list of all agent instances.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
Foglight 5.7.0 Transition Guide
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For each agent that is currently active and collecting data, the Collecting Data icon ( ) appears to the 

right of the Active State column ( ) in the row containing the agent record. Similarly, the Not Collecting 

Data icon ( ) indicates that an agent is active but is not collecting data:

To find out why an agent is not collecting data, see How Do I Fix the Agents That Are Not Connected? on 
page 13.

For more information about the Agent Status dashboard, see the Administration and Configuration Guide.

To find out if your agents are connected using the Agents on All Hosts dashboard:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Management Server > Agents.

The Agents on All Hosts dashboard appears in the display area.

Figure 4. Agents on All Hosts dashboard

3 Optional—if you plan to use this dashboard on a regular basis, you might want to add it to the Bookmarks 
for easy access. For instructions, see How Do I Bookmark a Dashboard for Easy Access? on page 25.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
Foglight 5.7.0 Transition Guide
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4 View the agents that are used to monitor a particular host.

a In the Monitored Hosts and Agents view, ensure that All Hosts is selected in the upper-left corner 
of the display area.

Figure 5. Selecting all hosts

b In the Monitored Hosts and Agents view, in the Name column, expand a host node.

A list containing one or more monitoring agent instances appears under the host node.

Figure 6. Selecting a monitoring agent instance

 

For each agent that is currently collecting data, in the Monitored Hosts and Agents view, the State 
column shows the agent status.

When the agent instance is running, the following status indicator appears:

▪ Collecting Data

When the agent instance is running but not collecting data, one of the following status indicators appear:

▪ Starting

▪ Stopped

▪ Stopping

▪ Unknown

5 Optional—choose a different host.

In the Monitored Hosts and Agents view, expand the host node.

A list of agents that are collecting data from the selected host appears under the host node.

To find out why an agent is not collecting data, see How Do I Fix the Agents That Are Not Connected? on 
page 13.

For more information about Foglight 5 dashboards, see the Foglight User Guide.

See also

• How Do I Get Started? on page 5

• How Do I Fix the Agents That Are Not Connected? on page 13

• How Do I Edit Agent Properties? on page 49

• How Do I Bookmark a Dashboard for Easy Access? on page 25
Foglight 5.7.0 Transition Guide
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How Do I Fix the Agents That Are Not 
Connected?
If you find Foglight® agents that are not collecting data, you can perform a series of steps that will help you 
determine the root of the problem. If an agent is not collecting data, on the Agent Status dashboard, the Not 
Collecting Data icon ( ) appears in the agent row.

Figure 7. Data collection stopped

To fix an agent that is not connected:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Agents > Agent Status.

The Agent Status dashboard appears, showing a list of all agent instances.

Figure 8. Agent Status dashboard

For those agent instances that are not collecting data, the Not Collecting Data icon ( ) appears in the 
agent row.

3 If an agent instance appears in the Agent Status dashboard, but is not collecting data (see To find out if 
your agents are connected using the Agent Status dashboard: on page 10), select the agent’s row in the list 
and click Start Data Collection in the lower-right corner.

4 If you cannot successfully start an agent’s data collection, or if the agent instance does not appear in the 
Agent Status dashboard, ensure that the Foglight Agent Manager is up and running. For more information, 
see How Do I Get Started? on page 5.

5 If the Foglight Client is up and running, check the agent’s log files. Foglight stores information about agent 
activities in agent log files whose name and location use the following syntax:

<agent_mgr_home>/state/default/logs/<cartridge_name>/<cartridge_version>/<agent_type>/<agent_insta
nce_name>@<host_name>_<yyyy>_<mm>_<dd>_
<hhmmss>_<file_ID>.log 

Where:

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
Foglight 5.7.0 Transition Guide
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▪ agent_mgr_home is the installation directory of the Foglight Agent Manager.

▪ cartridge_name is the name of the cartridge. For example, HostAgents.

▪ cartridge_version is the cartridge version. For example, 5.9.x.

▪ agent_type is the agent type. For example, WindowsAgent.

▪ agent_instance_name is the name of the agent instance.

▪ host_name is the name of the host computer. For example, Host2.example.com.

▪ yyyy, mm, dd, and hhmmss specify the date and time the agent instance was started.

For example:

C:\Quest_Software\Foglight_Agent_Manager\state\default\logs\HostAgents\5.9.x\WindowsAgent\Monitor
@Host2.example.com_2011-11-28_141933_001.log 

6 If you do not find any indicators in the log files, refer to the Foglight Release Notes and Administration and 
Configuration Help for more information.

7 If you do not find any relevant information in the documentation, contact Quest Support. See Contacting 
Quest on page 114.

See also

• How Do I Get Started? on page 5

• How Do I Know if My Agents Are Connected? on page 9

• How Do I Edit Agent Properties? on page 49

What is My Single Pane of Glass?
The browser interface allows you to create a dashboard that centers around your monitoring needs, and add it to 
the bookmarks for easy access. You can choose from a wide selection of portlet views that are available in the 
action panel on the right, and add them to your dashboard simply by dragging one or more views as required. 

The type and range of views that appear in the action panel depend on the selection of the active Foglight® 5 
cartridges in your monitoring environment, as well as your user permissions. For information on how to set user 
permissions in Foglight 5, see How Do I Limit a User’s Access? on page 104.

Your selection of views should reflect the nature of your monitoring role. For example, if your role involves 
monitoring the overall health of host machines in your network, you can add the following portlet views to your 
dashboard page:

• Host Summary Selector. Displays the state of the CPU, memory, disk, and network resources for a 
selected host computer.

• Alarm List with Filter. Lists all of the system alarms chronologically and shows the severity, host, and 
additional information for each alarm.

To add portlet views to a dashboard:

1 Evaluate your monitoring requirements.

2 Ensure that the navigation and action panels are open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

To open the action panel, click the left-facing arrow ( ) on the right.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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3 On the action panel, on the General tab, under Other Actions, click Create dashboard.

Figure 9. Create Dashboard wizard with the Build a Dashboard page open

4 Choose the type of data input for your dashboard.

In the Create Dashboard wizard, on the Build a Dashboard page, select Use All Data to build a 
dashboard from the available data elements, and click Next.

Figure 10. View Properties page in the Create Dashboard wizard

5 Specify the settings for the dashboard that you want to create.

For example, to name the dashboard My Alerts, and have it refresh automatically every five minutes, 
complete the following steps.
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a On the View Properties page, in the Name box, type My Alerts.

Note Some dashboards do not show an input table and you do not need to select inputs. This 
table provides a list of inputs on the current dashboard and appears when you are viewing a 
dashboard that has some inputs. In other words, if you do not know what information to 
include on your dashboard, you can leave the Inputs table as-is.

b Under Auto Refresh Rate, ensure that the 300 seconds (default refresh interval set in user 
preferences) option is selected.

c Optional—if required, limit the user access by specifying the user roles that are required for viewing 
this dashboard. For the purpose of this example, you can keep the default settings: none for the 
Relevant Role(s) and all for the Allowed Role(s). They act as filters, allowing a user to view only 
those dashboards that are applicable to their user needs. For more information, see the Web 
Component Guide.

d Optional—write help text for this dashboard by typing it into the Help box.

This text appears in a tooltip when you hover over the dashboard name in the navigation panel. For 
the purpose of this example, you can keep the Help box blank.

e Optional—if you want this dashboard to be available as a reportlet, select the Allow this view to 
be included in other views check box. For the purpose of this example, you can keep the check 
box clear.

6 In the Create Dashboard wizard, click Next.

Figure 11. Select Dashboard Layout page in the Create Dashboard wizard

7 Choose the type of layout for your custom dashboard. For example, to have the dashboard contents 
appearing in two columns, select Two-Column Layout, and click Finish.
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Figure 12. Add View wizard

The Add View wizard allows you to select data and a view type, and to add it to the newly created 
dashboard. For the purpose of this example, we will use a different approach: instead of selecting data 
elements and choosing a view type, we will add views that already exist in the system. 

8 Click Cancel to close the Add View wizard.

The newly created dashboard, My Alerts, appears in the display area. A node representing that 
dashboard, My Alerts, appears on the navigation panel under Dashboards > My Dashboards.

Figure 13. My Alerts dashboard

9 On the action panel, open the Views tab.

The Views tab shows the modules containing the views that you can add to your dashboard. The range of 
modules depends on the selection of installed cartridges.
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Figure 14. Views tab

 

10 Optional—observe the nodes representing the views that appear in the action panel. To see a list of views 
contained by a module, in the action panel, expand the node representing that module.

For example, expand the Management Server node.

A list of views and/or sub-nodes appears under the Management Server node.

Figure 15. Expanding the Management Server node

 

11 Optional—filter the views that appear in the action panel by role.

A role defines a set of tasks that a user can perform, and is assigned to one or more groups as required. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.

To filter the views, select the show by role check box.

The Views tab refreshes, showing a list of nodes, each representing a role.

Figure 16. Filtering views

12 On the Views tab, use the navigation tree to select one or more views that best represent your monitoring 
needs and add them to your dashboard.

To add a portlet view to the dashboard, expand the node representing the module that contains the view, 
and drag the view from the action panel to the dashboard.

For example, to add a view that shows all system alarms and changes to your dashboard, on the action 
panel, ensure the show by role check box is cleared, expand the Alarms module, followed by clicking and 
dragging the System Alerts and Changes node to the dashboard pane.
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Figure 17. All System Alerts and Changes view 

For complete information on how to add portlet views to dashboards, see the Foglight User Guide.

See also

• How Do I Get Started? on page 5

• What Dashboards Are Available? on page 19

• What is the Diagnostic Workflow? on page 32

What Dashboards Are Available?
Foglight® 5 offers a number of dashboards you can use to monitor your environment in real time. The type and 
range of available dashboards reflect the type of Foglight 5 cartridges in your monitoring environment and your 
user permissions. For information on how to set user permissions in Foglight 5, see How Do I Limit a User’s 
Access? on page 104.

There are several types of dashboards that you can access:

• Administration dashboards include a collection of dashboards that let you manage agents, cartridges, 
users, and thresholds. You can find them in the navigation panel under Dashboards > Administration.

• System dashboards include a set of core Foglight dashboards, and the dashboards that are installed with 
any cartridges that are running in your monitoring network. Typically, any dashboards that are accessible 
through the navigation panel, are core dashboards.:

▪ Dashboards > Alarms 

▪ Dashboards > Hosts 

▪ Dashboards > Management Server 

▪ Dashboards > Reports 

▪ Dashboards > Services 
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• User dashboards include any dashboards that you define. You can find them in the navigation panel under 
Dashboards > My Dashboards. For more information on how to create dashboards, see How Do I Build a 
Graph? on page 87.

• Configuration dashboards include a set of dashboards that let you look at data and create your own 
dashboards. You can find them in the navigation panel under Dashboards > Configuration.

• Cartridge dashboards are the dashboards that come with Foglight 5 cartridges. You can find them under 
Dashboards > cartridge, where cartridge is the cartridge name.

In addition to the system and user dashboards, you can add dashboards to the Bookmarks module for easy 
access if required. For instructions, see How Do I Bookmark a Dashboard for Easy Access? on page 25.

To view Foglight 5 dashboards:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 Observe the modules that appear in the navigation panel under Dashboards.

Figure 18. Dashboard modules

3 Look at administrative dashboards.

a On the navigation panel, under Dashboards, expand the Administration module.

A set of sub-modules appears under the Administration module.

Figure 19. Administration modules

Each of the sub-modules that appear contains one or more dashboards.

b Expand a sub-module and select a dashboard.

The dashboard appears in the display area. For example, to look at the Agent Status dashboard, 
under Dashboards, choose Administration > Agents > Agent Status.

The Agent Status dashboard appears in the display area.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 20. Agent Status dashboard

4 View a core Foglight dashboard.

a On the navigation panel, under Dashboards, expand the Management Server node.

A set of sub-modules appears under the Management Server node.

Figure 21. Management Server modules

b Expand a sub-module and select a dashboard.

The selected dashboard appears in the display area.

For example, to look at the Management Server View dashboard, on the navigation panel, under 
Dashboards, choose Management Server > Servers > Management Server View.

The Management Server View dashboard appears in the display area.
Foglight 5.7.0 Transition Guide
Finding Your Way Around

21



5 Look at the configuration dashboards.

a On the navigation panel, under Dashboards, expand the Configuration module.

A set of sub-modules appears under the Configuration module.

Figure 22. Configuration modules

Each of the sub-modules represents a dashboard.

b Select a sub-module. The dashboard appears on the right.

For example, to look at the Definitions dashboard that lets you create views, queries, and other Web 
components, under Dashboards, choose Configuration > Definitions.

The Definitions dashboard appears in the display area.
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Figure 23. Definitions dashboard

6 If you previously created any dashboards, you can access them using the My Dashboards node in the 
navigation panel.

a On the navigation panel, under Dashboards, expand My Dashboards module.

One or more sub-modules appear under the My Dashboards module.

Figure 24. My Dashboards module

b Select a sub-module that represent a dashboard.

The dashboard appears in the display area.

For example, to select the dashboard that was created in What is My Single Pane of Glass? on 
page 14, My Alerts, under Dashboards, choose My Dashboards > My Alerts.

The dashboard appears in the display area.
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Figure 25. My Alerts dashboard

7 Look at a cartridge dashboard.

For example, if you have the Infrastructure cartridge installed in your environment, on the navigation panel, 
under Dashboards, click the Infrastructure node.

The Infrastructure Environment dashboard appears in the display area.

Figure 26. Infrastructure Environment dashboard

See also

• How Do I Get Started? on page 5
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• What is My Single Pane of Glass? on page 14

• How Do I Bookmark a Dashboard for Easy Access? on page 25

• How Do I Share My Dashboards with Other Users? on page 27

• What is the Diagnostic Workflow? on page 32

• How Do I Build a Graph? on page 87

How Do I Bookmark a Dashboard for 
Easy Access?
If you plan to use one or more Foglight® 5 dashboards on a regular basis, you can add them to Bookmarks in 
order to quickly access them when required.

To add a dashboard to Bookmarks:

1 Ensure that both the navigation and action panels are open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

To open the action panel, click the left-facing arrow ( ) on the right.

2 Use the navigation panel to locate the dashboard that you want to add to Bookmarks.

For example, to bookmark the core Agents on All Hosts dashboard, on the navigation panel under 
Dashboards, choose Management Server > Agents.

The Agents on All Hosts dashboard appears in the display area.

Figure 27. Agents on All Hosts dashboard

 

3 On the action panel, on the General tab, under Actions, click Bookmark.

The Bookmark dialog box appears.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 28. Bookmark dialog box

 

4 Use the Bookmark dialog box to specify the settings for the Agents on All Hosts dashboard as required.

The Bookmark dialog box closes and the node representing the newly-bookmarked dashboard appears 
under Bookmarks on the navigation panel. If you chose to add the Agents on All Hosts dashboard to 
Bookmarks, the Agent on All Hosts module appears under Bookmarks on the navigation panel.

Figure 29. Agent on All Hosts module

5 On the navigation panel, click the newly-created bookmark.

The Agents on All Hosts dashboard appears in the display area.

Figure 30. Agents on All Hosts dashboard

See also

• How Do I Get Started? on page 5

• What is My Single Pane of Glass? on page 14

• What Dashboards Are Available? on page 19
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• How Do I Share My Dashboards with Other Users? on page 27

How Do I Share My Dashboards with 
Other Users?
When you create a dashboard, a module representing that dashboard appears in the navigation panel under 
Dashboards > My Dashboards. You can use that module to view the newly-created dashboard.

Other Foglight® users with the Cartridge Development and Operator roles can copy or edit that dashboard as 
needed. Assuming that you have the appropriate access permissions, you can view a dashboard that has been 
created by another user by copying it to your dashboard definitions. When you copy another user’s dashboard, 
view it by selecting the module representing that dashboard in the navigation panel, under Dashboards > My 
Dashboards.

For information on user permissions, see How Do I Create a User? on page 99 and How Do I Limit a User’s 
Access? on page 104; for information on how to create custom dashboards, see the Web Component Tutorial.

To view a dashboard created by another user:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Configuration > Definitions.

The Definitions dashboard appears in the display area, showing a navigation tree in the Definitions pane 
and a series of tabs in the lower-left pane.

Figure 31. Definitions dashboard

 

3 In the Definitions pane, ensure that My Definitions node in the navigation tree is selected.

4 In the lower-left pane, ensure the Views entry is selected.

5 Click . 

The Add View wizard appears.

NOTE: To complete this procedure, your user account must belong to a group with the Dashboard Designer 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 32. Add View wizard

 

6 Choose from existing views.

In the Add View wizard, open the Copy an Existing View tab.

On the Copy an Existing View tab, a navigation tree appears.

Figure 33. Copy an Existing View tab

 

7 On the Copy an Existing View tab, expand the Other User Views node.

One or more nodes appear under the Other User Views node, each representing a user.

Figure 34. Other User Views node

8 Expand the node representing the user whose dashboard you want to copy.

One or more views appear under the selected user node.
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Figure 35. Finding other users’ views

9 Select a view representing the dashboard that you want to copy and click OK.

The Add View wizard closes and the dashboard definitions appear in the right pane of the Definitions 
dashboard with the General tab open.

Figure 36. General tab

10 In the New View tab of the Definitions dashboard, click  to add that dashboard to your collection of 
dashboards.

In the lower-left pane of the Definitions dashboard, an entry representing that dashboard appears in the list 
of views.

Figure 37. Dashboard view

11 To view the contents of the newly copied dashboard, on the navigation panel, under Dashboards, expand 
My Dashboards module and select the node representing the newly-copied dashboard.

The contents of the selected dashboard appear in the display area.
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Figure 38. Viewing the contents of the copied dashboard

To edit a dashboard created by another user:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Configuration > Definitions.

The Definitions dashboard appears, showing a navigation tree in the Definitions pane and a series of tabs 
in the lower-left pane.

Figure 39. Definitions dashboard

3 In the Definitions pane, expand the Other User Definitions node.

One or more nodes appear under the Other User Definitions node, each representing a user.

Figure 40. Other User Definitions node

4 Click the node representing the user whose dashboard you want to edit.

In the lower-left pane, in the Views tab, one or more views appear.

NOTE: To complete this procedure, your user account must belong to a group with the Dashboard Designer 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 41. User definition views

5 Select a view representing the dashboard that you want to edit.

The dashboard definitions appear in the right pane of the Definitions dashboard.

Figure 42. Dashboard definitions

6 To edit the selected dashboard, in the right pane, click .

The dashboard definitions appear in the right pane of the Definitions dashboard with the General tab open.

Figure 43. Editing a dashboard
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7 Edit the dashboard definitions, as required.

For more information on how to edit or create a dashboard, see the Web Component Tutorial.

See also

• How Do I Get Started? on page 5

• What Dashboards Are Available? on page 19

• How Do I Bookmark a Dashboard for Easy Access? on page 25

• How Do I Create a User? on page 99

• How Do I Limit a User’s Access? on page 104

What is the Diagnostic Workflow?
Foglight® 5 allows you to set up the administrative interface in the way that best suits your monitoring role by 
bookmarking existing dashboards and using existing views to create new dashboards quickly and efficiently. The 
selection of dashboards and portlet views you can choose from largely depends on the monitoring requirements 
as well as your user role. Once you set up Foglight, you will quickly access dashboards and views of your choice 
in order to investigate problems in your monitoring environment and diagnose the cause of any bottlenecks.

Start by examining the available dashboards and views. If you find one or more dashboards that you want to use 
on a regular basis, you can add them to the bookmarks. For more information about Foglight 5 dashboards, see 
What Dashboards Are Available? on page 19. To acquire instant access to one or more portlet views, use the 
commands in the action panel to quickly create a dashboard and add those views to that dashboard. For 
instructions on how to add portlet views to a dashboard, see What is My Single Pane of Glass? on page 14.

Any dashboards that you create appear under Dashboards > My Dashboards while the existing dashboards that 
your bookmarked appear under Bookmarks in the navigation panel. For instructions, see How Do I Bookmark a 
Dashboard for Easy Access? on page 25. Once you add dashboards to the Bookmarks and My Dashboards 
modules, use those modules as a starting point in your investigation.

To view Bookmarks and My Dashboards:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 To view the contents of a dashboard that you previously added to Bookmarks, on the navigation panel, 
select the module that represents that dashboard under Bookmarks.

The contents of the selected dashboard appear in the display area.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 44. Dashboard appearing in the display area

For instructions on how to add a dashboard to Bookmarks, see How Do I Bookmark a Dashboard for Easy 
Access? on page 25.

3 To view the contents of a dashboard that you have previously created, on the navigation panel, under 
Dashboards, expand My Dashboards and select the module representing that dashboard.

The contents of the selected dashboard appear in the display area.

Figure 45. Viewing a selected dashboard

For information on how to create a dashboard, see How Do I Build a Graph? on page 87.

See also

• How Do I Get Started? on page 5

• What is My Single Pane of Glass? on page 14

• What Dashboards Are Available? on page 19

• How Do I Bookmark a Dashboard for Easy Access? on page 25.
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How Do I Create Custom Maps?
The concept of custom maps that existed in Foglight® 4 has been replaced by services in Foglight 5. A service is a 
collection of monitoring components that you can use to define your business processes. It can contain other 
logical components such as other services, as well as physical components such as host machines.

In Foglight 4, you used menu commands to create custom maps and add nodes—such as a city, subnet, or 
folder—and hosts to each custom map.

Figure 46. Creating custom maps in Foglight 4

In Foglight 5, you can use the Service Builder dashboard to create custom maps using services.

Figure 47. Foglight 5 Service Builder

Services can be used as equivalents of Foglight 5 maps, while categories in Foglight 5 can represent Foglight 4 
nodes. The relationship between categories, services, and hosts in Foglight 5 is equivalent to that of maps, nodes, 
and hosts in Foglight 4, as illustrated in the following diagram.
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Figure 48. Maps and services

Like maps in Foglight 4, a category in Foglight 5 can have one or more services, while a service can have on one 
or more hosts. For the purpose of the following example you will create a category called MyCustomMap, add a 
service to the MyCustomMap category, MyNode, and finally, add a host to the MyNode service. The layout and 
functionality of the resulting structure in Foglight 5 resembles a Foglight 4 custom map.

To create a custom map using the Service Builder dashboard:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Services > Service Builder.

The Service Builder dashboard appears in the display area.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 49. Service Builder

3 Create a new map.

a In the upper-left corner of the Service Builder dashboard, click Add A New Category.

The New Category Wizard appears.

Figure 50. New Category Wizard

b In the New Category Wizard, in the Name box, type the map name. For example: MyCustomMap.

c Optional—use the Short Description and Description boxes to add information about the custom 
map that you are about to create, and select one of the Perspective options to describe the 
category type.

Leave the other settings at their default values.

d Optional—to automatically add any hosts that support any objects that you are about to add, 
ensure that Yes is selected. This is a default setting. For the purpose of this example, there is no 
need to change it.

e Click Finish.

The New Category Wizard closes and the newly added service category representing your custom 
map appears in the Service Builder dashboard.
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Figure 51. New service category in the Service Builder

4 Add a node to the custom map.

a On the Service Builder dashboard, in the row containing the newly created service component, in 

the Add column, click .

A menu appears.

Figure 52. Adding components to a service 

b In the menu, click Create a child service.

A menu appears.

Figure 53. Creating a child service

c In the menu, click New Local Service.

The New Service For MyCustomMap wizard appears.

Figure 54. New Service For MyCustomMap wizard

d In the New Service For MyCustomMap wizard, in the Name box, type the node name.

For example, MyNode.

e Optional—use the Short Description and Description boxes to add information about the node 
that you are about to add, and select one of the Perspective options to describe the service type.

Leave the other settings at their default values.
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f Click Finish.

g When the New Service For MyCustomMap wizard closes, expand the MyCustomMap node on 
the Service Builder dashboard.

The newly-created node, MyNode, appears under MyCustomMap.

Figure 55. Node added to the service

 

5 Add a host to the newly-created node in your custom map.

a In the row containing the newly created service component, in the Add column, click .

A menu appears.

Figure 56. Adding components to a service 

b In the menu, click Add components to this service.

The Add Service Components dialog box appears.

Figure 57. Add Service Components dialog box

c In the Add Service Components dialog box, click Add specific component.

The Add specific components dialog box appears.
Foglight 5.7.0 Transition Guide
Finding Your Way Around

38



Figure 58. Add specific components dialog box

d Select a desired host object and click Add Components.

The Add specific components dialog box closes and the Service Builder dashboard refreshes, 
showing the newly added host node.

Figure 59. Host added to the service tree

See also

• How Do I Get Started? on page 5

• Where Are the Service Models? on page 39

Where Are the Service Models?
In Foglight® 5, you can re-create your Foglight 4 service models using the Service Builder dashboard.

To open the Service Builder dashboard:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Services > Service Builder.

The Service Builder dashboard appears in the display area.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 60. Service Builder dashboard

3 Add or remove services as required.

For complete instructions on how to add a service, see Step 3 through Step 5 in To create a custom map 
using the Service Builder dashboard: on page 35.

For more information about the Service Builder dashboard, see the Foglight User Guide.

See also

• How Do I Get Started? on page 5

• What is My Single Pane of Glass? on page 14

• How Do I Create Custom Maps? on page 34

Why Do I See Only One Set of System 
Agent Variables?
In Foglight® 4, each OS agent includes its own set of registry variables, including CPUFatal, CPUCritical, 
CPUWarning, and others. These variables can be viewed and edited in the Foglight Registry viewer, by navigating 
to WORLD > Default Agents > Operating System Agent.
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Figure 61. Foglight 4 Registry 

The default values of the CPUFatal, CPUCritical and CPUWarning variables are the same for each agent 
type:

• CPUWarning: 70

• CPUCritical: 80

• CPUFatal: 90

These defaults are editable and can be changed for individual agent types by double-clicking the registry variable 
in the Foglight Registry viewer, and editing its value in the Registry Entry dialog box.
Foglight 5.7.0 Transition Guide
Finding Your Way Around

41



Figure 62. Editing registry variables in Foglight 4

In Foglight 5, each cartridge (including core and installed cartridges) can include its own collection of registry 
variables. For example, the Infrastructure cartridge, used to monitor OS performance, includes a set of registry 
variables that are used to evaluate the CPU usage:

• INF_CPUUseWarning: 70

• INF_CPUUseCritical: 80

• INF_CPUUseFatal: 90

These variables can be found on the Manage Registry Variables dashboard.

Figure 63. Manage Registry Variables dashboard in Foglight 5

Foglight 5 registry variables are used in rules and derived metrics to customize behavior. Every registry variable 
can have any of the following values:

• A global value

• A value bound to a particular type, such as Windows_Host or Linux_Host
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• A value bound to a particular instance, such as Host1 on a particular host

Foglight determines the value of a registry variable at run-time by scoping on types and instances.

For example, you can use this capability to direct alarm emails to appropriate targets, by configuring the 
SYSADMIN registry variable. This variable is included with the Management Server, and Foglight uses it to control 
where alarm emails are sent. Most often this value is set globally. In some implementations, it is quite common to 
have different system administrators manage different hosts and OS platforms. Beyond that, you can set up a 
special value for a particular host by scoping on a specific Host object instance.

For example:

• Global System Monitoring: Admin@example.com

• Windows® System Monitoring: WindowsGroup@example.com

• Linux® System Monitoring: LinuxSysAdmin@example.com

• Host-Specific Monitoring:

▪ Host Object Instance: Host1.example.com

▪ Administrator: john.smith@example.com

Figure 64. Editing a registry variable in Foglight 5

The above setup results in emailing all alarms to the global Admin@example.com email. In addition, Windows-
related alarms are sent to the Windows email alias, and all Linux-related alarms to the Linux email alias. Any 
alarms associated with Host1.example.com are also sent to John.Smith@example.com, regardless of the 
host’s OS.

To email alarms to selected recipients:

1 Ensure that the navigation panel is open.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Rules & Notifications > Manage 
Registry Variables.

The Manage Registry Variables dashboard appears, listing all available registry variables.

Figure 65. Manage Registry Variables dashboard

3 On the Manage Registry Variables dashboard, locate the row containing the SYSADMIN variable.

Figure 66. SYSADMIN variable

4 In the Variable Name column, click SYSADMIN.

A menu appears.

Figure 67. Editing the SYSADMIN variable

5 In the menu, click View and Edit Details.

The Manage Registry Variables dashboard refreshes, showing the Edit Registry Variable view.

TIP: You can filter the list of variables using filters. At the top of the Manage Registry Variables 
dashboard, in the Search box, type SYSADMIN.
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Figure 68. Edit Registry Variable view

6 Specify the global email address.

a In the top part of this view, locate the Global Default value, and click Change on the right.

The Global Value Wizard dialog box appears.

Figure 69. Global Value Wizard dialog box

b In the Global Value Wizard dialog box, ensure that Static Value is selected, and type the global 
administration address. For example, Admin@example.com.

c Click Finish.

The Global Value Wizard dialog box closes.

7 Specify the email addresses for different host types. For the purpose of this example, use the following 
values:

a In the Registry Values view, click Add.

The Registry Value Wizard appears.

Table 1. Topology objects used to specify email addresses

Topology Type Topology Object Name Registry Value

Windows_Host N/A WindowsGroup@example.com

Linux_Host N/A LinuxGroup@example.com

Host Host1.example.com John.Smith@example.com
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Figure 70. Registry Value Wizard

b In the Registry Value Wizard, select the appropriate topology instance, and click Next. For 
example, to add the Windows_Host type, select this type in the list, and click Next.

The Registry Value Wizard refreshes, showing all object instances of the selected type.

For the purpose of this example, there is no need to scope on any specific Windows_Host or 
Linux_Host instances, because you want to send alarms to the appropriate groups whenever any 
of these instances are affected.

However, when associating Host1.example.com with John.Smith@example.com, you must 
scope on Host1.example.com which is an instance of the Host type.

c When scoping on Windows_Host and Linux_Host types, do not specify any of the types, just 
click Next.

When scoping on Host1.example.com, select the host instance in the list, and click Next.

The Registry Value Wizard refreshes.

Figure 71. Registry Value Wizard

o

d In the Registry Value Wizard, ensure that Static Value is selected, and type the applicable email 
address.

e Click Finish.

The Registry Value Wizard closes.

To add another email address, scoped to the other monitored host, repeat this step. 

When add you all of the topology-scoped value, observe the entries in the Registry Values table.

TIP: Use the Search box to look up a particular type name.

TIP: Host1.example.com is a fictional host name made up for the purpose of this example. 
It is very unlikely to have a host with that name in your environment. You can choose any host 
instance to proceed with this exercise.
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Figure 72. Registry Values table

For complete information about registry variables, see the Administration and Configuration Help.

See also

• How Do I Get Started? on page 5

• How Do I Edit a Registry Variable? on page 52

• How Do I Edit a Rule? on page 54

Can Multiple People Share My User 
Name?
Foglight® 5 supports simultaneous sessions. If necessary, you can share your user name and password with other 
users in order to log into the browser interface simultaneously, but this is not recommended. When multiple users 
share a single user name, Foglight associates any operations that those users perform with that one user name 
and logs them as applicable, which can complicate the audit process.

Regardless of the type of the session—simultaneous or unique—the type and range of features that are available 
through the Foglight Console reflect your user permissions. For information on how to set user permissions in 
Foglight 5, see How Do I Limit a User’s Access? on page 104.

See also

• How Do I Get Started? on page 5

• How Do I Share My Dashboards with Other Users? on page 27

• How Do I Create a User? on page 99

• How Do I Limit a User’s Access? on page 104

Can I Configure Everything to Look and 
Feel Like Foglight 4?
The look and feel of Foglight 5 is quite different from Foglight® 4. Probably the first thing you notice is the absence 
of the FOC, and the fact that the entire user interface is Web-based, similar to the Web Console in Foglight 4. In 
Foglight 5 you use the browser interface to manage users, agents, cartridges, data, views, and other entities. For 
more information, see Where’s the FOC? on page 8. For information on where to find some of the common 
interface components that were available in Foglight 4, such as service model or rule browsers, see Appendix: 
Finding Foglight 4 Components in Foglight 5 on page 112.
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If you are planning to use the IP map on a regular basis, one thing you can do is add the Foglight 5 equivalent of 
the IP map, the Agents on All Hosts dashboard, to the Bookmarks. For instructions on how to add a dashboard to 
Bookmarks, see How Do I Bookmark a Dashboard for Easy Access? on page 25.

See also

• How Do I Get Started? on page 5

• Where’s the FOC? on page 8

• What is My Single Pane of Glass? on page 14

• How Do I Bookmark a Dashboard for Easy Access? on page 25

• What is the Diagnostic Workflow? on page 32
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3

Setting Up For Long-Term Use

This section describes some of the typical tasks you will perform after you install Foglight® 5. The tasks include 
editing agent properties, rules, user permissions, looking at collected metrics, and similar operations. For complete 
information, you can refer to the Administration and Configuration Guide and the Foglight User Guide.

• How Do I Edit Agent Properties? on page 49

• How Do I Edit a Registry Variable? on page 52

• How Do I Edit a Rule? on page 54

• How Do I Select Table Data in Rule Conditions? on page 59

• How Do I Promote a Rule Severity? on page 75

• How Do I Edit a Blackout Schedule? on page 80

• How Do I Build a Graph? on page 87

• How Do I Build and Schedule a Report? on page 90

• How Do I Add Views and Data to a Report? on page 95

• How Do I Create a User? on page 99

• How Do I Limit a User’s Access? on page 104

• Where Do I Find the Data? on page 108

How Do I Edit Agent Properties?
Foglight® 5 uses agent properties to specify what type of data to collect or to define collection or purging intervals. 
Foglight 5 agent properties are equivalent to agent startup parameters (ASPs) in Foglight 4. In Foglight 4, you 
used the Edit ASP dialog box to configure ASPs.

NOTE: Each of the procedures in this chapter continues from How Do I Get Started? on page 5.
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Figure 73. Edit ASP dialog box in Foglight 4

In Foglight 5, use the Agent Properties dashboard to edit agent properties. The Agent Properties page allows you 
to edit the properties of an agent instance, or the properties of all agents of the same type.

Figure 74. Agent Properties dashboard in Foglight 5

Agent startup parameters are called agent properties in Foglight 5. In Foglight 4, tabs in the Edit ASP dialog box 
show different groups of ASPs. In Foglight 5, agent properties appear on the same page, but they appear in 
different groups, such as Properties, Event Log, and so on. Every agent type has a unique set of agent properties.
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To edit agent properties:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Agents > Agent Status.

The Agent Status dashboard appears, showing the list of all agent instances.

Figure 75. Agent Status dashboard

3 Select an agent in the list.

The row containing information about the selected agent appears highlighted in the list and several 
commands appear in the lower-right corner. The type of commands depends on the agent status. For 
example, if you select an agent that is currently collecting data, the commands include Edit Properties, 
Edit Tags, Get log, Stop Data Collection, Deactivate, and Delete; when you select an inactive agent, the 
commands are as follows: Edit Properties, Edit Tags, Get log, Activate, and Delete. 

4 Click Edit Properties.

The property page appears, showing the properties of the selected agent.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 76. Selected agent properties

5 Edit the agent’s properties as required. 

For complete information about agent properties, see the Administration and Configuration Guide.

See also

• How Do I Get Started? on page 5

• How Do I Know if My Agents Are Connected? on page 9

• How Do I Fix the Agents That Are Not Connected? on page 13

How Do I Edit a Registry Variable?
In Foglight® 4, you used the Foglight Registry dialog box in the FOC to add, edit, and manage variables.
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Figure 77. Foglight 4 Registry

The scope of a variable was dictated by system or user-defined domains, such as WORLD, SERVICES, and 
REPORTS.

In Foglight 5, note that registry variables can have both global and scope-related values. The Foglight 5 topology 
determines the scope which means that in addition to global values, a variable can have multiple values that are 
specific to particular topology objects.

Figure 78. Editing a Foglight 5 registry variable

In Foglight 5, use the Manage Registry Variables dashboard to view and edit registry variables. You can filter the 
list of registry variables using different criteria, such as topology, object, default values and cartridge. To edit a 
registry variable, click that entry in the list and edit the settings, as required.

To edit a registry variable:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 In navigation panel, under Dashboards, choose Administration > Rules & Notifications > Manage 
Registry Variables.

The Manage Registry Variables dashboard appears, listing all available variables.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 79. Manage Registry Variables dashboard

3 In the Manage Registry Variables dashboard, in the Variable Name column, click the variable that you 
want to edit.

The Edit Registry Variable view appears in the Manage Registry Variables dashboard, showing the 
settings for the selected registry variable.

Figure 80. Edit Registry Variable view

4 Edit the registry variable as required.

For complete instructions, see the Administration and Configuration Help.

See also

• How Do I Get Started? on page 5

• Why Do I See Only One Set of System Agent Variables? on page 40

• How Do I Edit a Rule? on page 54

How Do I Edit a Rule?
In Foglight® 4, you used the Rule Browser to look at rules and the Rule Editor to edit rules.
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Figure 81. Foglight 4 Rule Browser and Rule Editor

When you start using Foglight 5, you can view your old rules in the Rule Managemnet dashboard, and drill down to 
the Edit Rule view to edit a rule.
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Figure 82. Foglight 5 Rule Management dashobad and Edit Rule view

The Rule Managment dashboard allows you to select a rule and drill down to the Edit Rule view for the selected 
rule in order to define thresholds for severity levels (multiple-severity rules) or the Fire state (simple rules). Similar 
to Foglight 4, each rule has settings for the Fatal, Critical, Warning, and Normal severities, or the Fire state. Use 
the Manage Rules dashboard to list, and if required, filter the rules, and to drill down to the Edit Rule view.

To edit a rule:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Rules & Notifications > Rule 
Management.

The Rule Management dashboard appears, listing all available rules.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 83. Rule Management dashboard

 

3 Optional—to filter the rules, use the Search box, or filter by cartridge. 

For example, to get a list of rules included with the Infrastructure cartridge, and in the list that appears, 
select Infrastructure.

The list of rules refreshes, showing only the rules that exist in the specified cartridge.

Figure 84. Filtering the list of rules

4 On the Rule Management dashboard, in the Rule column, click the rule that you want to edit.

A menu appears.

Figure 85. Actions associated with a rule

5 In the menu, click View and Edit.

The Rule Detail dialog box appears.
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Figure 86. Rule Detail dialog box

6 In the Rule Detail dialog box, in the top-right corner, click Rule Editor.

The Edit Rule Page appears for the selected rule with the Conditions, Alarms, & Actions tab open, 
showing the properties of the selected rule, and a separate pane for each severity: Fatal, Critical, 
Warning, Normal, and Undefined.

Figure 87. Edit Rule Page

7 Edit the rule as required.

For complete instructions, see the Foglight Administration and Configuration Help.

See also

• How Do I Get Started? on page 5

• How Do I Edit a Registry Variable? on page 52
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• How Do I Select Table Data in Rule Conditions? on page 59

• How Do I Promote a Rule Severity? on page 75

How Do I Select Table Data in Rule 
Conditions?
In Foglight® 4, you used rule conditions to select table data and to compare it with desired thresholds. In the Rule 
Editor, right-clicking the Condition box and choosing Field from the menu that appears (new conditions), or double-
clicking a field name in the Condition box (existing conditions), invokes the Define Field dialog box that allows you 
to select a table field and add it to the rule condition, as illustrated below.

Figure 88. Foglight 4 Rule Editor, data selection flow for existing rules
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Figure 89. Foglight 4 Rule Editor, data selection flow for new rules

The process of selecting one or more table fields in rule conditions is referred to as scoping on rules. In Foglight 4, 
you can select any table data that is associated with the agent type whose rule you are editing.

Foglight 5 also allows for scoping on rules but with a greater degree of flexibility. Unlike the Foglight 4 schema that 
uses static, flat files, for storing collected metrics, Foglight 5 data models have a dynamic, tree-like structure, that 
consists of nodes. Each node is an object instance of a topology type, and each topology type includes a set of 
properties. Foglight 5 tables contain object instances as table records. Equivalent to table fields, where each field 
can store a certain type of data, as specified in the table definitions, each object property can contain a predefined 
data type, defined in the topology type that the object is an instance of.

Going back to the process of scoping on rules, a Foglight 5 rule definition can include a scoping query. Unlike the 
data selection statements in Foglight 4, a Foglight 5 query is not a part of the rule condition, it is specified prior to 
writing rule condition, which de-couples data selection, or the process of scoping on rules, from conditional 
expressions. In rule conditions, you can still make references to individual data elements without having to select 
the entire data set, thereby simplifying the conditional expressions and minimizing potential errors. De-coupling 
data selection from conditional expressions is particularly useful in complex expressions, making their 
troubleshooting easier and more efficient.

In Foglight 5, conditional expression syntax requires the use of hash marks ‘#’ as data element delimiters. When 
you select a type in a scoping query, you reference their properties by enclosing them in hashmarks, as illustrated 
below.

Foglight 5: Scoping query
Host.cpus

Foglight 5: Conditional expression
#utilization# >= registry("INF_CPUUseCritical") && #runQueueLength from $scope.host# 
> registry("INF_ProcsRunQueueCritical")

In the above example, both utilization and runQueueLength are metric properties of the scoped 
Host.cpus topology type, while CPUCritical and RunQueueCritical are registry variables, hence the 
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difference in the syntax. For more information about the query and conditional expression syntax, see the 
Administration and Configuration Help. 

Figure 90. Data selection in Foglight 4 rule conditions
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Figure 91. Data selection in Foglight 5 rule definitions

Figure 92. Foglight 5 conditional expressions

NOTE: The query that appears in the above illustration is not the default expression that is included with the 
Windows_System agent’s CPU_Utilization rule. It is modified for the purpose of this example.
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Another benefit of separating the data selection from conditional expressions in Foglight 5 is that the scoping 
queries have access to the entire database, not just the tables that are associated with a particular agent or 
cartridge, as this was a case in Foglight 4. What this means is that when you start writing a query in Foglight 5, you 
can select any topology type, including the topology types that come with the Foglight Management Server, or any 
types that come with any of the installed cartridges. The range of topology types that exist in your installation 
depends on the nature and complexity of your monitoring environment, and the collection of the installed 
cartridges.

Figure 93. Selecting data in Foglight 4 rules

TIP: You can find out which topology types you have available by looking at the Schema Browser 
dashboard. A node representing this dashboard can be found in the navigation panel, under Dashboards > 
Dashboard Development > Schema Browser. For more information about the Schema Browser 
dashboard, see the Dashboard Support Guide.
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Figure 94. Choosing a Foglight 5 rule scope

In Foglight 5, a scoping query can be used to select all object instances of a selected type, as seen in the above 
example, or can include a property matching filter that selects one or more specific object instances, based on a 
property value. The following example shows an example where a scoping query includes a property matching 
filter.

Foglight 5: Scoping query with a property matching filter

Syntax

TopologyType where PropertyName=PropertyValue

Where:

• TopologyType is the name of the topology type of the object instance that you want to select.

• PropertyName is the name of the property of the selected topology type that you want to use as a filter in 
the data selection.

• PropertyValue is the specific property value that you want to use to select only specific object instances of 
the selected topology type.

Example

Host.cpus where utilization = '95'

For more information about scoping queries, their syntax and usage examples, see the Administration and 
Configuration Help.
Foglight 5.7.0 Transition Guide
Setting Up For Long-Term Use

64



Figure 95. Foglight 5 scoping queries

The query language in Foglight 5 requires that you follow a specific syntax for selecting data. You write queries 
either by typing them directly or by using the Scoping Query Editor. The selections you choose in the Scoping 
Query Editor translate into query expressions as you make your selections. Similarly to the use of the Scoping 
Query Editor, the conditional operators and the Condition Editor in rule conditions make the process of referencing 
registry variables and metric properties easier. Any selections you make in the Condition Editor can be added to 
the conditional expressions quickly and easily.

NOTE: The query that appears in the above illustration is not the default expression that is included with the 
Windows_System agent’s CPU_Utilization rule. It is modified for the purpose of this example.
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Figure 96. Foglight 5 Condition Editor

Figure 97. Foglight 5 Sciping Query Editor

To write a scoping query and a conditional expression for a rule:

1 Create a new rule.

In this rule, you create a scoping query to select a specific host instance based on its name, and write a 
conditional expression for the rule’s Warning severity. The rule uses this condition to evaluate the hosts’s 
available paging space, and generates an alarm when the condition is met.

a Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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b On the navigation panel, under Dashboards, choose Administration > Rules & Notifications > 
Create Rule.

The Create Rule dashboard appears in the display area with the Rule Definition tab open.

Figure 98. Create Rule dashboard

2 Get started with the rule definitions.

In this step, you specify the rule name along with its type and trigger.

a Specify the rule name.

On the Create Rule dashboard, on the Rule Definition tab, in the Rule Name box, type the rule 
name. For example, My Test Rule.

b Set the rule type to multiple severity.

At a later step in this procedure, after having written a scoping query and a conditional expression, 
you will compose an alarm message that is generated when the rule condition is met. Foglight 5 
includes two rule types: simple rules and multiple-severity rules. While simple rules do not raise 
alarms—they just fire, multiple-severity rules can generate alarms associated with each severity 
level. The rule you are about to create will have an active warning condition, and an alarm message 
associated with that condition. For complete information about different rule types, see the 
Administration and Configuration Help.

On the Rule Definitions tab, under Rule Type, select the Multiple-Severity Rule option. 

c Ensure that the rule trigger is data-driven.

Foglight 5 has three types of rule triggers: time-driven, data-driven, and event-driven triggers. The 
Foglight Management Serer evaluates data-driven rules as it collects the related. For complete 
information about the different rule triggers, see the Administration and Configuration Guide.

On the Rule Definitions tab, under Rule Triggering, ensure that the Data Driven option is 
selected.

3 Write a scoping query for your rule to select a specific object instance from the topology model.
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In this step, you write a scoping query for this rule to select a desired Host object from the topology model 
using its name as a property matching filter, followed by validating the query expression. You do that by 
selecting the Host type using the Topology Type box and specifying the property matching filter in the 
Scoping Query Editor, as described below. For complete information about scoping queries and the 
Scoping Query Editor, see the Administration and Configuration Guide.

a On the Rule Definitions tab, in the Rule Scope area, click the Topology Type box and in the list 
that appears, under Core, select the Host entry.

b In the Rule Scope area, click the Scoping Query Editor button .

The Scoping Query Editor dialog box appears, with the Instances tab open.

Figure 99. Scoping Query Editor dialog box

The Instances tab shows the object instances of the Host topology type, selected in Step a. In this 
procedure, you select an existing Host object instance using its name. The names of existing 
objects instances appear in the Topology Instances list on this tab. Choose one specific object 
instance and record its name. You will use it in the next step.

c Narrow down your data selection to one specific object instance using the name property value of 
the selected Host object instances as a filter.

In the Scoping Query Editor dialog box, open the Filter tab.

Figure 100. Filter tab

On the Filter tab, click the upper-left Properties box and select the name entry from the list that 
appears. Ensure that the box to its right is set to is equal to, and in the box next to it, type the host 
name recorded in Step b.

d On the Filter tab, click the upper-right box, and set it to a blank entry.

TIP: The topology types that appear in this list represent the entire collection of the types that 
exist in your topology model, including the types that come with the Foglight Management 
Server, along with the types that come from any of the installed cartridges.

TIP: The Filter tab allows you to create a property matching clause in the query expression. 
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e In the Scoping Query Editor dialog box, click Insert Query.

On the Create Rule dashboard, on the Rule Definitions tab, the Rule Scope area refreshes, 
showing the newly created scoping query.

Figure 101. Inserting a query

f Close the Scoping Query Editor dialog box.

g Validate the scoping query by clicking the Validate Rule Scope button .

The Rule Scope area refreshes, indicating that the scoping query is valid, and shows the name of 
the selected object instance.

Figure 102. Rule scope validation

4 Get started with creating a condition and an alarm message for the rule by moving to the next step in the 
workflow.

On the Create Rule dashboard, click the Next button in the upper-left corner.

Figure 103. Create Rule dashboard flow

The Conditions, Alarms, & Actions tab opens on the Create Rule dashboard.
Foglight 5.7.0 Transition Guide
Setting Up For Long-Term Use

69



Figure 104. Conditions, Alarms, & Actions tab

You will use this tab to create a Warning condition that evaluates a metric property of the object instance 
selected in Step 3.

5 Get started with composing the conditional expression and alarm message for the rule’s Warning severity.

On the Create Rule dashboard, on the Conditions, Alarms, & Actions tab, click the Warning bar. 

A pane containing the definitions for the Warning severity expands under the Warning bar, with the 
Condition tab open.

Figure 105. Warning condition

6 Define the rule condition for the Warning severity.

The conditional expression that you are about to write compares the value stored in the selected Host 
object’s availablePagingSpace property with the value of the PageSpaceWarning registry variable. 
When the metric value exceeds the value stored in the registry variable, Foglight generates a Warning 
alarm associated with this rule. Both values indicate the percentage of the available paging space.The 
default value of the PageSpaceWarning registry variable is 20.

To write the conditional expression, use the Condition Editor and the relational operators appearing on top 
of the Condition box, as described below. For complete information about rule conditions and scoping 
queries and the Condition Editor, see the Administration and Configuration Guide.
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Use the Condition Editor and conditional operators to create the expression, as described below.

h In the Warning area, on the Condition tab, click the Condition Editor button .

The Condition Editor dialog box appears with the Registry Variable tab open.

Figure 106. Condition Editor 

i Add the availablePagingSpace metric to the expression. The rule compares the value of this 
metric with the PageSpaceWarning registry variable, with the metric as a left operand in the 
relational expression and the registry variable as the right operand, with the greater than operator 
‘>’ between the two operands:

#availablePagingSpace# > registry ("PageSpaceWarning")

In the Condition Editor dialog box, open the Metric/Property tab. On the Metric/Property tab, in 
the Type of Scope area, click Host. In the Metrics area that appears, click availablePagingSpace, 
followed by clicking the Insert button.

In the Warning pane, on the Condition tab, the Condition box refreshes, showing the 
availablePagingSpace metric, newly-added to the conditional expression.
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Figure 107. Adding a metric to conditional expression

j Add the greater than operator ‘>’ to the expression by clicking the greater than sign on top of the 
Condition box.

Figure 108. Adding an operator to conditional expression

k Add the PageSpaceWarning registry variable as a right operand to the expression.

In the Condition Editor dialog box, open the Registry Variable tab. On this tab, in the Registry 
Variables list, click the PageSpaceWarning entry, followed by clicking the Insert button.

In the Warning pane, on the Condition tab, the Condition box refreshes, showing the 
PageSpaceWarning registry variable, newly added to the conditional expression.

Figure 109. Adding a registry variable to conditional expression

l Evaluate the conditional expression.

m Validate the conditional expression by clicking the Validate Condition button  on top of the 
Condition box.
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In the Warning pane, the Condition tab refreshes, indicating that the conditional expression is 
valid.

Figure 110. Conditional expression validation

7 Define the alarm message that you want to generate when the Warning condition is reached..

Alarm messages contain expressions that can contain both literal text strings and severity-level variables. 
Severity-level variables can reference any registry variables or metrics that are available to the rule, as 
specified by its scoping query. At run-time, they form a meaningful statement in the form of an alarm 
message that indicates the nature of the problem when the alarm is generated. Before you get started with 
defining an alarm message, you need to define all of the severity-level variables that you want to use in the 
alarm message. For more information, see the Administration and Configuration Guide.

The purpose of the alarm message that you are about to write is to inform the end-user about the amount 
of free paging space on the selected host. It uses two severity-level variables: the first one (var1) contains 
the host name while the second one (var2) contains the percentage of the available paging space.

a Specify the severity variables for the alarm message.

In the Warning pane, open the Severity Level Variables tab.

Figure 111. Severity Level Variables tab

b Use this tab to add the two severity variables to the rule. The definitions of each variable are listed 
in the following table.

To add a variable, specify its type, name, and expression, followed by clicking the Add button.

c Return to the Condition tab in the Warning pane.

d In the Warning pane, on the Condition tab, in the Alarm Message box, type the following alarm 
message:

Table 2. Severity-Level Variables

Name Value Type

var1 scope.get("name") Expression

var2 scope.get("availablePagingSpace") Expression
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Free page space on host @var1: @var2% remaining. Low 
page space decreases the system performance.

With var1 being set to the host name, and var2 set to the amount of available paging space, the 
above message syntax generates an alarm message similar to the following one:

Free page space on host myHost: 10% remaining. Low 
page space decreases the system performance.

8 Activate the Warning condition and save the rule by clicking the Activate check box on the Condition tab of 
the Warning pane, followed by clicking the Finish button in the upper-left corner.

Figure 112. Activating a condition

The Create Rule dashboard refreshes, indicating that the rule is successfully added to the system, and 
showing the rule summary.

Figure 113. Rule successfully added

See also

• How Do I Get Started? on page 5
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• How Do I Edit a Rule? on page 54

• How Do I Promote a Rule Severity? on page 75

How Do I Promote a Rule Severity?
In Foglight® 4, you used the Rule Editor to promote the rule severity if an alarm triggered by a rule remains in the 
same state for a certain amount of time.

Figure 114. Foglight 4 Rule Editor

In Foglight 5, use the Edit Rule view to promote a rule severity using time-based functions and multi-condition 
expressions. Use the OR operator to separate conditions in expressions and the avg function to return the rule 
severity in each individual condition during a desired time period. 

For example, you can create a multi-condition expression that triggers a critical alarm if a rule remains in a warning 
state for 30 minutes along with a fatal alarm if the rule remains in the same state for 60 minutes.
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Figure 115. Multiple condition expression

To promote a rule severity:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Rules & Notifications > Rule 
Management.

The Rule Management dashboard appears in the display area, listing all available rules.

Figure 116. Rule Management dashboard

3 On the Rule Management dashboard, locate and click the rule to which you want to assign a time-based 
severity.

4 On the Rule Management dashboard, in the Rule column, click the rule that you want to edit. For example, 
CPUUtilization.

A menu appears.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 117. Editing a rule menu

5 In the menu, click View and Edit.

The Rule Detail dialog box appears.

Figure 118. Rule Detail dialog box

6 In the Rule Detail dialog box, in the top-right corner, click Rule Editor.

The Edit Rule Page appears for the selected rule with the Conditions, Alarms, & Actions tab open, 
showing the properties of the selected rule, and a separate pane for each severity: Fatal, Critical, 
Warning, Normal, and Undefined.
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Figure 119. Edit Rule Page

7 Add a time-based severity to the Warning condition.

a In the Edit Rule view, click Warning.

A pane containing the settings for the Warning condition expands under the Warning bar.

Figure 120. Warning condition 

 

b Observe the Warning condition for the CPUUtilization rule:

#utilization# >= registry("INF_CPUUseWarning") && 
#runQueueLength from $scope.host# > registry("INF_ProcsRunQueueWarning")

c Copy the Warning condition without making any changes to it.

8 Add a time-based severity to the Critical condition that will cause the CPU_Utilization rule to trigger a 
critical alarm if it remains in a warning state for 30 minutes.

a In the Edit Rule view, click Critical.

A pane containing the settings for the Critical condition expands under the Critical bar.

TIP: Click the Warning bar to collapse the pane.
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Figure 121. Critical condition

b Observe the Critical condition of the CPU_Utilization rule:

#utilization# >= registry("INF_CPUUseCritical") && 
#runQueueLength from $scope.host# > registry("INF_ProcsRunQueueCritical")

c Add the Warning condition that you copied in Step 7 immediately below the existing lines of code 
and edit the expression as follows:

(#utilization# >= registry("INF_CPUUseCritical") && 
#runQueueLength from $scope.host# > 
registry("INF_ProcsRunQueueCritical")) || 

(avg(#utilization for 30 minutes#) >= registry("INF_CPUUseWarning") && 
avg(#runQueueLength from $scope.host for 30 minutes#) > 
registry("INF_ProcsRunQueueWarning")) 

This updated conditional expression now causes the rule to trigger a critical alarm if the rule meets 
the original condition, or if it remains in a warning state for 30 minutes.

d Copy the Critical condition.

9 Add a time-based severity to the Fatal condition that will cause the CPU_Utilization rule to trigger a critical 
alarm if it remains in a warning state for 30 minutes, and a fatal alarm if the rule remains in a warning state 
for 60 minutes.

a In the Edit Rule view, click Fatal.

A pane containing the settings for the Fatal condition expands under the Fatal bar.

Figure 122. Fatal condition

b Observe the Fatal condition for the CPU_Utilization rule:

TIP: Click the Critical bar to collapse the pane.
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#utilization# >= registry("INF_CPUUseFatal") && 
#runQueueLength from $scope.host# > registry("INF_ProcsRunQueueFatal")

c Add the Critical condition that you edited in Step 8 immediately below the existing lines and edit the 
expression as follows:

(#utilization# >= registry("INF_CPUUseFatal") && 
#runQueueLength from $scope.host# > registry("INF_ProcsRunQueueFatal")) 
|| 

(avg(#utilization for 30 minutes#) >= registry("INF_CPUUseCritical") && 
avg(#runQueueLength from $scope.host for 30 minutes#) > 
registry("INF_ProcsRunQueueCritical")) || 

(avg(#utilization for 60 minutes#) >= registry("INF_CPUUseWarning") && 
avg(#runQueueLength from $scope.host for 60 minutes#) > 
registry("INF_ProcsRunQueueWarning")) 

This updated conditional expression now causes the rule to trigger a fatal alarm if the rule meets the 
original condition, or if it remains in a critical state for 30 minutes, or if it remains in a warning state 
for 60 minutes.

See also

• How Do I Get Started? on page 5

• How Do I Edit a Rule? on page 54

• How Do I Select Table Data in Rule Conditions? on page 59

How Do I Edit a Blackout Schedule?
An agent blackout is a scheduled event during which the agent does not collect data for set intervals. For example, 
you might want to set the times when regularly scheduled maintenance is performed on a server as the blackout 
period for the agents that run on that server.

In Foglight® 4, you used the Blackout Manager dialog box to look at agent blackout schedules, and the Schedule 
Rule Blackout and Immediate Blackout dialog boxes to prevent agent rules from firing.

Figure 123. Foglight 4 Blackout Manager
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Figure 124. Scheduling and assiging rule blackouts in Foglight 4

 

Along with agent blackouts, Foglight 5 allows you to assign blackout schedules to topology objects. Foglight 5 
uses the data it collects to create topology models. A topology model is a graph that contains topology nodes. 
Each node represents an object instance of a topology type. Unlike agent blackouts, which prevent the data 
collection for the agent instance to which the blackout is assigned, topology object blackouts only prevent any 
rules from analyzing that object, without interrupting their data collection. For information about assigning 
blackouts to agents and topology objects, see the Administration and Configuration Help.

The way you assign blackout schedules is somewhat different in Foglight 5. In Foglight 4, you typically select an 
agent in the Rule Browser and assign one of the existing blackout schedules to prevent one or more rules from 
firing.

In Foglight 5, you use blackout schedules to prevent agents from collecting data. You can use an existing schedule 
or create another one if required.

To edit and assign a blackout schedule:

1 Edit a schedule using the Manage Schedules dashboard and Edit Schedule view.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 125. Manage Schedules dashboard

For instructions, see To edit a schedule: on page 82.

2 Assign the edited schedule to an agent using the Blackouts dashboard.

Figure 126. Blackouts dashboard

For instructions, see To assign a blackout schedule to an agent instance: on page 83.

To edit a schedule:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Schedules > Manage 
Schedules.

The Manage Schedules dashboard appears, listing all available schedules.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 127. Manage Schedules dashboard

3 In the Manage Schedules dashboard, in the Schedule Name column, click the schedule that you want to 
edit.

The Edit Schedule dialog box appears, showing the properties of the selected schedule.

Figure 128. Edit Schedule dialog box

4 Edit the schedule as required.

For complete instructions, see the Administration and Configuration Help.

To assign a blackout schedule to an agent instance:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Administration > Setup & Support > Blackouts.

The Blackouts page appears in the display area.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
Foglight 5.7.0 Transition Guide
Setting Up For Long-Term Use

83



Figure 129. Blackouts page

3 Indicate that you want to create a scheduled blackout.

On the Blackouts page, click Create a Scheduled Blackout.

The display area refreshes, showing the first step in the Create Blackout Wizard.

Figure 130. Create Blackout Wizard

4 Indicate that you want to black out agents.

In the Create Blackout Wizard, select Suspend Data Collection, and click Next.

The display area refreshes, showing the next step in the wizard.

IMPORTANT: Blacking out an agent instance stops the data collection for that instance.
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Figure 131. Select Agents to Suspend Data Collection step

5 Indicate that you want to choose agents by selecting specific agent instances.

In the Create Blackout Wizard, ensure that Select the Agents Directly from a List is selected, and click 
Next.

The display area refreshes, showing the next step in the wizard.

Figure 132. Select Agents to Black Out step

6 Choose the agent instances whose data collection you want to stop.

In the Create Blackout Wizard, select one or more rows containing the agent entries, and click Next.

The display area refreshes, showing the next step in the wizard.

CAUTION: Selecting an agent instance stops its data collection.

TIP: To select all agent instances, use the check box at the top of the list.
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Figure 133. Choose a Blackout Schedule step

The list shows the schedules that exist in your Foglight installation and their descriptions. This includes 
default schedules packaged with Foglight, and any schedules that you create.

7 Select a schedule that you want to associate with the topology blackout.

a Review the list of schedules.

b If you do not find a schedule that meets your needs, you can create a new one.

To create a new schedule, click Create New Schedule and follow the flow in the Simple New 
Schedule Wizard. For more information, see the Administration and Configuration Help.

c Select the schedule that you want to assign to the topology blackout and click Next.

The display area refreshes, showing a default name for the blackout.

Figure 134. Configure Name and Reason step

8 Optional. Specify a different name or a reason for the blackout.

For example:

▪ Blackout Name: Scheduled blackout for Host agents

▪ Reason for Blackout: Daily maintenance

IMPORTANT: Choosing to create or edit the existing schedules causes you to exit the wizard.

IMPORTANT: Specifying a reason for the blackout is not mandatory, but is strongly recommended.
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Click Finish.

The display area refreshes, showing the blackout summary.

Figure 135. Blackout Summary

9 Click Go to Manage Blackouts Page.

The Manage Blackouts dashboard appears in the display area. The newly created blackout appears on the 
list.

Figure 136. Manage Blackouts dashboard

For more information about blackout schedules, see the Administration and Configuration Help.

See also

• How Do I Get Started? on page 5

• How Do I Edit Agent Properties? on page 49

• How Do I Build and Schedule a Report? on page 90

How Do I Build a Graph?
In Foglight® 4, you used the View Editor to create different types of graph views.
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Figure 137. Foglight 4 View Editor

Typically, you followed the same workflow that included choosing the graph type, writing queries to extract 
information from one or more tables, and reviewing the graph.

In Foglight 5, use the Definitions dashboard to create a graph view.

Figure 138. Foglight 5 Definitions dashboard

Start by creating a new chart or copying an existing one, and define or edit the data sources and context for the 
graph. Additionally, if you plan to use that graph on a regular basis, you can promote it to a dashboard and add it 
to the bookmarks for easy access. For information on how to bookmark a dashboard, see How Do I Bookmark a 
Dashboard for Easy Access? on page 25 on page 25.

To build a graph:

1 Ensure that the navigation panel is open.

NOTE: To complete this procedure, your user account must belong to a group with the Dashboard Designer 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
Foglight 5.7.0 Transition Guide
Setting Up For Long-Term Use

88



To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Configuration > Definitions.

The Definitions dashboard appears, showing a navigation tree in the upper-left pane and a series of tabs in 
the lower-left pane.

Figure 139. Definitions dashboard

3 In the Definitions pane, ensure that My Definitions node in the navigation tree is selected.

4 In the lower-left pane, ensure the Views entry is selected.

5 Click .

The Add View dialog box appears.

Figure 140. Add View dialog box

In the Add View dialog box, on the Create a Blank View tab, a navigation tree shows different groups of 
views.

The Common and Charts and Gauges nodes contain graph objects or charts. You can use any of the 
available chart objects to create a graph.

6 Choose the type of view that you want to create. 

TIP: In addition to creating blank views, you can also copy existing views and modify them as 
desired. For more information, see the How Do I Share My Dashboards with Other Users?, How Do I 
Share My Dashboards with Other Users? on page 27.
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For example, to build a plot chart that shows how a metric changes over time, choose Charts and Gauges 
> Time Plot Chart, followed by clicking OK.

The Add View dialog box and the pane on the right of the Definitions dashboard refreshes to show a series 
of tabs that let you define view properties, with the General tab open.

Figure 141. General tab

7 Use the tabs in the Definitions pane to define your chart as required.

▪ General: Specifies the chart name, description, size, and role.

▪ Context: Specifies the context keys.

▪ Configuration: Specifies the look of components in the view and their source of data.

▪ Flow: Specifies context-related application flows.

For examples on how to create and edit charts and other types of views, see the Web Component Tutorial. 
For detailed information about the components that appear in the Definitions dashboard, see the Web 
Component Guide.

See also

• How Do I Get Started? on page 5

• What Dashboards Are Available? on page 19

• How Do I Share My Dashboards with Other Users? on page 27

How Do I Build and Schedule a Report?
In Foglight® 4, you used the Report Browser to browse through reports.
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Figure 142. Foglight 4 Report Browser

Foglight 5 includes the Reports dashboard that allows you to create, schedule, and browse through existing 
reports.

Figure 143. Foglight 5 Reports dashboard

In addition to the Reports dashboard that lets you choose from existing report templates, you can quickly create a 
custom report by assembling it from one or more views and data objects. For more information, see How Do I Add 
Views and Data to a Report? on page 95.

To build and schedule a report:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Reports.

The Reports dashboard appears in the display area.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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Figure 144. Reports dashboard

The Reports dashboard provides access to different workflows for working with reports.

3 Choose the workflow for building and scheduling a report.

On the Reports dashboard, click Run a Report.

The Run Report wizard appears. 

Figure 145. Run Report wizard

4 Choose the report template.

Foglight includes a set of predefined report templates that define the data that appears in the report and its 
layout. Select a report template from the list and click Next.

The Run Report wizard refreshes.
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Figure 146. Run Report wizard, Set Input Parameters step

The information you see in the dialog box describes the selected report template and lists the report inputs.

5 Edit the report inputs, as required, and click Next.

The Run Report wizard refreshes.

Figure 147. Run Report wizard, Set Properties step

Specify the report name, report format, the number of entries in the report, and one or more email 
recipients (using comma ‘,’ as a separator) to which the report is sent to. Ensure that 
Schedule This Report is selected.

The Run Report wizard refreshes.

IMPORTANT: To enable Foglight to send reports to email recipients, ensure that Foglight email 
notifications are properly configured. For more information, see the Administration and Configuration 
Help.
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Figure 148. Run Report wizard, Select Schedule step

.

6 Choose a schedule from the list and click Next. If you do not find a schedule that meets your needs, click 
New Schedule and follow the workflow for creating new schedules. For more information about this 
workflow, in the Simple New Schedule Wizard that appears, click Help.

The Run Report wizard refreshes, showing the report summary.

Figure 149. Report summary

.

7 Click Finish.

The Run Report wizard closes, and a status indicator appears.

Figure 150. Run Report wizard, status indicator

After a few moments, the report appears.
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Figure 151. Newly created report

8 Optional. You can find the newly created report in the list of scheduled reports.

To do that, on the Reports dashboard, click Manage Reports.

The Scheduled Reports view shows the report in the list.

Figure 152. Scheduled Reports view

See also

• How Do I Get Started? on page 5

• How Do I Add Views and Data to a Report? on page 95

How Do I Add Views and Data to a 
Report?
In Foglight® 4, reports contained views. You used the Report Wizard to choose from existing views and add them 
to reports.
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Figure 153. Foglight 4 Report Wizard

Foglight 5 allows you to quickly create a report by choosing from a range of views associated with data objects. 

Figure 154. Creating a report in Foglight 5

In addition to creating reports by selecting data objects and their views, you can also create a report using a report 
template, browse through existing reports and schedule them as needed using the Reports dashboard. For more 
information, see How Do I Build and Schedule a Report? on page 90.

To add views and data to a report:

1 Ensure that the navigation and action panels are open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

To open the action panel, click the left-facing arrow ( ) on the right.

2 On the action panel, ensure that the General tab is open.

3 On the action panel, on the General tab, under Other Actions, click Reports, and choose Create a New 
Report from the menu that appears.

The Create Report dialog box appears.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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Figure 155. Create Report dialog box 

 

4 In the Create Report dialog box, ensure that the Use All Data option is selected and click Finish.

The Create Report dialog box closes and the Add View wizard appears, allowing you to add input data to 
the report.

Figure 156. Add view wizard

5 Specify the input data for the report.

In the Add view wizard, use the Input Data tree to choose the topology object instance that you want to 
use as the source of information for the report.

For example, to display a list of current alarms in the report, in the Input Data tree, choose Alarms > 
Current Alarms.
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Each object instance can have one or more views associated with it. These views can have simple metrics 
and tabular layouts, and appear as graph views whose appearance can be controlled with a set of chart 
templates. The layout of a view depends on the data type with which it is associated, and any related 
definitions in the cartridge in which the view is defined. In the Input Data table, the right-most column 

indicates the layouts that can be used for the view associated with the selected object instance: metric , 

table , template . 

6 Observe the available layouts for the selected view.

Figure 157. Available view layots

7 Choose the view template.

In the Add view wizard, under View Styles, ensure that the Select a View Template option is selected, 
and click Next.

The Add view wizard refreshes.

The Select a view pane contains a data tree that you can use to choose a view, listed by data modules.

8 Optional—filter the views that appear in the action panel by role.

A role defines a set of tasks that a user can perform, and is assigned to one or more groups as required. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.

To filter the views, in the Add view wizard, select the show by role check box.

The Select a view pane refreshes, showing a list of nodes, each representing a role. Each role contains 
one or more views that can be accessed by a user with that role.

Figure 158. Selecting a view by role

9 In the Add view wizard, on the Preview tab, observe the view.

10 Click Finish.

The Add view wizard closes and the display area refreshes, showing your report with the newly created 
view.
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Figure 159. Viewing the report

The Alarm List view in the report represents the view. 

11 To see the contents of this view, click Preview .

A dwell appears, showing the contents of the selected view.

Figure 160. Observing the contents of a view

From here, you can add more views to the report, text, header and footer, and run and schedule the report. A node 
representing this report appears on the navigation panel, under Dashboards > My Dashboards. You can use it to 
access this report at a later time. For more information about reports and their usage in Foglight, see the Foglight 
User Help.

See also

• How Do I Get Started? on page 5

• How Do I Build and Schedule a Report? on page 90

How Do I Create a User?
In Foglight® 4, you used the Foglight Access Manager to create users and assign them to groups as required. 
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Figure 161. Foglight 4 Access Manager

In Foglight 5, use the Users tab in the User Management view to create users. This view is accessible from the 
Users & Security Management dashboard.

Figure 162. Foglight 5 User Management

When you create a user for the first time, you supply their user name and password, and then specify their access 
permission. For information on how to edit users’ permissions at a later time, see How Do I Limit a User’s Access? 
on page 104.

To create a user:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

NOTE: To complete this procedure, your user account must belong to a group with the Administrator role. 
For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 104.
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2 On the navigation panel, under Dashboards, choose Administration > Users & Security.

The Users & Security Management dashboard appears.

Figure 163. Users & Security Management dashboard

3 On the Users and Security Management dashboard that appears in the display area, click Manage Users, 
Groups, Roles.

The User Management view appears in the display area with the Users tab open.

Figure 164. User Management view

4 Start the workflow for creating new users.

On the Users tab, click New User.

The New User dialog box appears.
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Figure 165. New User dialog box

5 Specify the user names and email addresses for one or more user accounts that you want to create.

When creating multiple users, the set of access permissions defined in this flow applies to every user you 
create. You can edit their permission at a later time, if required.

a In the Name box, type the user name; in the Email box, type the email address.

For example, test_user.

b To specify additional user names, click Add more names, and type them into the list that appears, 
followed by clicking Add.

c Click Next.

The New User dialog box refreshes.

Figure 166. User groups

The list of available groups in the wizard shows the roles that are included with Foglight, and any additional 
groups that are created after the installation. In the above example, only the default groups appear due to 
the absence of added groups. To quickly find a desired group, for example, if the list of groups is too long, 
you can issue a search.

6 Select one or more groups that you want this user to belong to, followed by clicking Next. Adding a user to 
a group grants that user access to all of the roles that are associated with the group.

If access requirements associated with this user account change at a later time, you can change their 
groups and roles by editing the user details. For more information, see the Administration and 
Configuration Help.

TIP: The maximum length of Name is 15 characters; the maximum length of Email is 80 
characters.
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The New User dialog box refreshes.

Figure 167. Specifying the user’s password

7 Specify the password for the user account you are about to create in each of the Password and Confirm 
Password boxes.

If you are creating multiple users, the password you specify here applies to each of those user accounts.

Selecting Change Password in the next logon protects the user credentials by ensuring that the user you 
are about to create is asked to change their password after the first successful logon attempt. This is useful 
if you are creating multiple user accounts using this flow. Forcing the password change in this step causes 
each of those users to change their individual passwords, thereby protecting their user credentials.

Click Finish.

A message box appears, indicating the user creation is in progress.

Figure 168. Saving user data

After a successful user creation, the message box closes. The Users tab refreshes, showing the newly 
created user entry.

Figure 169. User created

For more information about managing users in Foglight 5, see the Administration and Configuration Guide.

See also

• How Do I Get Started? on page 5

• How Do I Share My Dashboards with Other Users? on page 27

• Can Multiple People Share My User Name? on page 47

• How Do I Limit a User’s Access? on page 104
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How Do I Limit a User’s Access?
In Foglight® 4, you used the Groups and Maps tabs in the Foglight Access Manager to define user permissions.

Figure 170. Foglight 4 Access Manager, Groups and Maps tabs

While Foglight 4 makes use of groups and IP maps to limit a user’s access, Foglight 5 defines the users’ access 
through groups and roles. In Foglight 5, you can administer users, groups, and roles using the Users & Security 
dashboard.
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Figure 171. Foglight 5 Users & Security dashboard

Each user belongs to one or more groups and each group can have one or more roles. The set of tasks that a user 
has access depends on the roles that are either assigned to the groups that user is a member of, or directly to the 
user account. For example, in a typical Foglight 5 installation, a member of the Foglight Operators group has the 
Console User role which gives them access to the Common, Core, and Foglight dashboards, but not the 
Administration dashboards. Assigning the Administrator and Security roles to that user grants access to the 
Administration dashboards.

The following table shows a set of default groups found in a typical Foglight 4 environment and identifies their 
equivalents in Foglight 5:

Use the Users tab in the User Management view to create users. This view is accessible from the Users & Security 
Management dashboard.

Table 3. Default user groups

Foglight 4 Foglight 5

security Foglight Security Administrators

foglight Foglight Administrators

admin Foglight Administrators

operator Foglight Operators

helpdesk Foglight Operators

NOTE: Unlike the operator group in Foglight 4 that grants the users a permission to create and edit views, 
the Foglight Operators group in Foglight 5 does not include access to dashboard creation. A workaround 
would be to create a custom group, assign the Dashboard Designer role to that group, and then ensure that 
the user belongs to both groups: the custom group with the Dashboard Designer role and the Foglight 
Operators group.
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Figure 172. Users tab in the User Management view

To limit a user’s access:

1 Add the user to one or more groups.

For instructions, see To add a user to a group: on page 106.

2 Assign one or more roles to the user account.

For instructions, see To assign a role to a user: on page 107.

To add a user to a group:

1 On the navigation panel, under Dashboards, choose Administration > Users & Security.

2 On the Users and Security Management dashboard that appears in the display area, click Manage Users, 
Groups, Roles.

The User Management view appears in the display area with the Users tab open.

Figure 173. Users tab

3 On the Users tab, in the row containing the user account that you want to edit, click the Groups column.

A dialog box appears, showing the existing groups. Any groups that are already associated with the user 
account appear selected. If you are editing groups for an external account, and any of the external groups 
the user belongs to are selected for visibility on the Groups tab, those groups also appear in the list, but 
are disabled for selection.

NOTE: To complete this procedure, your user account must belong to a group with the Security role.
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Figure 174. Available user groups

4 In the dialog box, use the check boxes on the left to add or remove groups, as required.

5 Click Save.

A message box appears, indicating the progress.

Figure 175. Assigning groups to users

After a few moments, the message box closes.

6 Observe the Groups column on the Users tab. Hovering over this column shows the list of current groups, 
taking into account the latest changes.

To assign a role to a user:

1 On the navigation panel, under Dashboards, choose Administration > Users & Security.

2 On the Users and Security Management dashboard that appears in the display area, click Manage Users, 
Groups, Roles.

The User Management view appears in the display area with the Users tab open.

Figure 176. Users tab 

3 On the Users tab, in the row containing the user account that you want to edit, click the Roles column.

A dialog box appears, showing the existing roles. Any roles that are already associated with the user 
account appear selected.

NOTE: To complete this procedure, your user account must belong to a group with the Security role.
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Figure 177. Available user roles

4 In the dialog box, use the check boxes on the left to grant a role to the user.

5 Click Save.

The dialog box closes and a message box appears, indicating the progress.

Figure 178. Granting roles to users

After a few moments, the message box closes.

6 Observe the Roles column on the Users tab. Hovering over this column shows the list of current roles, 
taking into account the latest changes.

See also

• How Do I Get Started? on page 5

• How Do I Share My Dashboards with Other Users? on page 27

• Can Multiple People Share My User Name? on page 47

• How Do I Create a User? on page 99

Where Do I Find the Data?
In Foglight® 4, you used the Data Browser to look at the data.

NOTE: Individual roles that are granted to the user though group membership cannot be removed 
from the user account, and appear disabled for selection. Removing such a role requires removing 
the user from all groups to which that role is granted. This will, however, disable access to all roles 
that are associated with the groups from which the user is removed. You can add them to the user 
account at a later time, as described in this procedure.
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Figure 179. Foglight 4 Data Browser

When you start using Foglight 5, you can use any of the following ways to look at the data:

• Find the data in agents’ views and tables. 

Figure 180. Foglight 5 agent views and tables

• Use the Data Browser.
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Figure 181. Foglight 5 Data Browser

To look at the data using the Data Browser:

1 Ensure that the navigation panel is open.

To open the navigation panel, click the right-facing arrow ( ) on the left.

2 On the navigation panel, under Dashboards, choose Configuration > Data.

The Data dashboard appears in the display area, showing a navigation tree in the left pane.

Figure 182. Data dashboard

The navigation tree contains nodes that represent collection models in Foglight 5. Each node in a collection 
model can have properties, metrics, and other nodes associated with it. Foglight Management Server adds 
these entities to the collection models as it collects data.

3 Expand a node and look at its structure.

For the purpose of this exercise, we will look at the memory metrics collected by a Host agent. This agent 
is available with the Infrastructure cartridge, assuming that you have that cartridge installed.

NOTE: To complete this procedure, your user account must belong to a group with the Advanced Operator 
role. For more information about users, groups, and roles, see How Do I Limit a User’s Access? on page 
104.
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In the left pane, navigate to Management Server > All Agents > <Host agent instance> >monitoredHost 
> Memory.

The Data Browser appears in the right pane, showing the data collected in the Server_Table of the selected 
agent instance.

Figure 183. Data Browser

For more information about the Data Browser, see the Web Component Guide.

See also

• How Do I Get Started? on page 5
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A

Appendix: Finding Foglight 4 
Components in Foglight 5

Quick Reference Sheet

Table 4. Foglight® 4 Components in Foglight 5

Component Name
Where to Find It in Foglight 5

Foglight 4 Foglight 5

Access 
Manager

Users & Security 
Management 
dashboard

Browser interface > navigation panel > Dashboards > 
Administration > Users & Security

Agent 
Browser

Agent Browser
Browser interface > navigation panel > Dashboards > Management 
Server > Agents > Monitored Hosts and Agents > Host > Agent

Agent views
Select a View dialog 
box

Browser interface > navigation panel > Dashboards > Management 
Server > Agents > Monitored Hosts and Agents > Host > Agent > 
Related > Views

Data Browser
Data Browser 
dashboard

Browser interface > navigation panel > Dashboards > Configuration 
> Data > Management Server > All Agents > Agent > Metrics

Edit ASP 
dialog box

Edit properties view
Browser interface > navigation panel > Dashboards > 
Administration > Agents > Agent Status > Agent > Edit Properties

FOC Browser interface Web browser > http://FMS_host_name:FMS_port_number/console

Foglight 
Registry 
dialog box

Manage Registry 
Variables dashboard

Browser interface > navigation panel > Dashboards > 
Administration > Rules & Notifications > Manage Registry 
Variables

Help Help Browser interface > action panel > Help

IP Map
Agents on All Hosts 
dashboard

Browser interface > navigation panel > Dashboards > Management 
Server > Agents

Report 
Browser

Reports dashboard
Browser interface > navigation panel > Dashboards > Reports

Rule Blackout 
dialog boxes

Blackout 
Configuration 
dashboard

Browser interface > navigation panel > Dashboards > 
Administration > Setup & Support > Blackouts

Rule Editor Edit Rule view
Browser interface > navigation panel > Dashboards > 
Administration > Rules & Notifications > Rule Management > Rule 
> View and Edit > Rule Editor

Scheduler
Manage Schedules 
dashboard

Browser interface > navigation panel > Dashboards > 
Administration > Schedules > Manage Schedules

Service Model 
Browser

Service Builder 
dashboard

Browser interface > navigation panel > Dashboards > Services > 
Service Builder

View Editor
Definitions 
dashboard

Browser interface > navigation panel > Dashboards > 
Configuration > Definitions > Views > View > Edit
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About Us
We are more than just a name
We are on a quest to make your information technology work harder for you. That is why we build community-
driven software solutions that help you spend less time on IT administration and more time on business innovation. 
We help you modernize your data center, get you to the cloud quicker and provide the expertise, security and 
accessibility you need to grow your data-driven business. Combined with Quest’s invitation to the global 
community to be a part of its innovation, and our firm commitment to ensuring customer satisfaction, we continue 
to deliver solutions that have a real impact on our customers today and leave a legacy we are proud of. We are 
challenging the status quo by transforming into a new software company. And as your partner, we work tirelessly to 
make sure your information technology is designed for you and by you. This is our mission, and we are in this 
together. Welcome to a new Quest. You are invited to Join the Innovation™.

Our brand, our vision. Together.
Our logo reflects our story: innovation, community and support. An important part of this story begins with the letter 
Q. It is a perfect circle, representing our commitment to technological precision and strength. The space in the Q 
itself symbolizes our need to add the missing piece — you — to the community, to the new Quest.

Contacting Quest
For sales or other inquiries, visit https://www.quest.com/company/contact-us.aspx/.

Technical support resources
Technical support is available to Quest customers with a valid maintenance contract and customers who have trial 
versions. You can access the Quest Support Portal at https://support.quest.com.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a 
day, 365 days a year. The Support Portal enables you to:

• Submit and manage a Service Request.

• View Knowledge Base articles.

• Sign up for product notifications.

• Download software and technical documentation.

• View how-to-videos.

• Engage in community discussions.

• Chat with support engineers online.

• View services to assist you with your product.
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